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1 ЛАБОРАТОРНА РОБОТА №1 

ПІДГОТОВКА СЕРЕДОВИЩА AUTOCAD ДО РОБОТИ 

 
Мета роботи: ознайомитись з основними прийомами роботи у  

середовищі AutoCAD 2016. 

 

1.1 Теоретичні відомості 

На рис. 1.1 представлене вікно AutoCAD 2016. 

 

 

Рисунок 1.1 – Головне вікно AutoCAD 2016 

 

1.1.1 Панелі AutoCAD 2016 

У лівому верхньому куті вікна розташована кнопка 

додатку (Application Button) при натисканні якої 

відкривається меню додатка (рис. 1.1). Воно містить загальні 

інструменти для створення, збереження та публікації. 
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Рисунок 1.2 - Меню додатка Application Menu 

Опис пунктів меню додатка наведений у таблиці 1.1. 

Таблиця 1.1 – Пункти меню додатка 

Назва Команда Опис 

New NEW Створення нового 

листа 

Drawing  Створення листа для 

креслення 

Sheet Set  Створення набору 

листів 

Open OPEN Відкрити файл 

Drawing  Відкрити креслення 

Drawing from the 

Cloud 

 Відкрити креслення з 

мережевого сховища 

Sheet Set  Відкрити набір листів 

DGN  Імпорт файла з DGN в 

DWG файл 

Sample Files  Відкрити файли 

прикладів 

Save SAVE Зберегти документ 
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Назва Команда Опис 

Save as SAVEAS Зберегти документ як: 

Drawing  креслення 

Drawing from the 

Cloud 

 креслення у мережеве 

сховище 

Drawing Template  шаблон креслення 

Drawing Standarts  стандарти креслення 

Other Formats  в інших форматах 

Save Layout as a 

Drawing 

 зберегти шар як 

креслення 

DWG Convert  DWG Конвертація 

Export EXPORT Експорт файлу в: 

DWG  формат DWX (формат 

обміну даними) 

DWFx  формат DWFx 

3D DWF  формат 3D DWFx 

PDF  формат PDF 

DGN  формат DGN 

FBX  формат FBX 

Other Formats  в інші формати 

Publish PUBLISH Опублікувати 

Send to 3D Print 

Service 

 друк на 3D принтері 

Archive  архівація набора 

листів 

eTransmit  створити пакет  

залежних документів 

Email  електронна пошта 

Upload Multiple 

Files to 

 завантажити файли на 

Autodesk 360 

Print PLOT Друк 

Plot  Друк на плотері, 

принтері або в файл 

Batch Plot  Груповий друк, 

публікація 

Plot Preview  Попередній перегляд 



 6 

Назва Команда Опис 

View Plot and 

Publish Details 

 Інформація о 

виконаних публікаціях 

Page Setup  Настройка сторінки 

Manage Plotters  Управління плотером 

Edit plot Style 

Tables 

 Редагування таблиць 

стилів друку 

Drawing Utilities  Інструменти 

креслення 

Drawing Properties   Властивості креслення 

Units   Одиниці вимірювання 

Audit   Перевірка цілісності 

креслення 

Status   Стан 

Purge   Чистка документів від 

невикористаних 

елементів 

Recover   Відновлення 

пошкодженого файлу 

креслення 

Open the Drawing 

Recovery Manager 

 Відкрити список 

креслень які можливо 

необхідно відновити 

Close CLOSE Закрити 

Current Drawing  Поточне креслення 

All Drawing  Всі креслення 

Options OPTIONS Опції 

Files  Файли 

Display  Відображення  

Open and Save  Відкрити та зберегти 

Plot and Publish  Друг і публікації 

System  Системи 

налаштування 

User Preferences  Користувацькі 

налаштування 

Drafting  Креслярські 

налаштування 
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Назва Команда Опис 

3D Modeling  3D Моделювання 

Selection  Вибір  

Profiles  Профілі  

Online  Онлайн налаштування 

Налаштування AutoCAD 2016 здійснюється за допомогою вікна 

Options (рис. 1.3), яке можна визвати натисканням кнопки Options 

знизу меню додатка Application Menu (див. рис. 1.2). 

 

Рисунок 1.3 — Вкладки вікна Options (Опції) 

У верхній частині екрану розташована панель інструментів 

швидкого доступу до команд (рис. 1.4), загальний опис набору кнопок 

за замовчанням наведено у таблиці 1.2. 

 

Рисунок 1.4 - Панель інструментів швидкого доступу 

Таблиця 1.2 – Опис кнопок панелі швидкого доступу 
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Назва кнопки Команда Опис 

New NEW Новий 

Open OPEN Відкрити 

Save QSAVE Зберегти 

Save as SAVEAS Зберегти як 

Plot PLOT Друк 

Undo UNDO Відмінити 

Redo REDO Повторити 

Customize Quick 

Access Toolbar 

 Настройка панелі інструментів 

швидкого доступу (активація 

прихованих кнопок) 

Для креслення, постановки розмірів, редагування зображення 

можливе використання стрічкових інструментальних панелей, 

призначених для швидкого виклику команди за допомогою піктограм 

(рис. 1.5). 

 

Рисунок 1.5 - Вигляд інструментальної панелі Home 

 

Ці панелі розташовані у верхній частині екрана, їх кількість та 

положення можна змінювати у процесі роботи. В разі потреби можна 

також створювати власні панелі, на які збирати команди, необхідні для 

виконання конкретних задач. Прийоми роботи з інструментальними 

панелями розглядаються у лабораторній роботі №3. 

Для швидкого пошуку у довідковій системі і доступу до 

мережевих служб у заголовку вікна AutoCAD 2016 праворуч 

розташована група інструментів (рис. 1.6). 

 

Рисунок 1.6 — Права частина заголовку вікна AutoCAD 2016 
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Під робочою областю знаходиться командний рядок (рис.1.7), 

за допомогою якого вводяться команди з клавіатури, а також 

задаються необхідні параметри команд та префікси (представлені в 

таблиці 1.3). 

 

 

Рисунок 1.7 - Вигляд командного рядку 

 

Таблиця 1.3 – Префікси команд AutoCAD 

 

Префікс Призначення префікса 

' (апостроф) Для виконання однієї команди, не перериваючи 

виконання іншої 

- (дефіс) Режим вводу параметрів команди у командному 

рядку замість вікна 

_ (підкреслення) Необхідний для використання англомовних команд 

в локалізованих версіях 

 

В нижній частині екрану під командним рядком знаходиться 

рядок стану, у якому можуть виводитись поточні координати курсору 

розташовані кнопки вмикання/вимикання режимів креслення 

(рис. 1.8). Крім того він дозволяє перейти з одного простору креслення 

в інший (кнопка MODEL). За замовчанням рядок стану містить 

обмежений набір кнопок, змінити який можна натиснувши 

кнопку Customization праворуч. 

 

Рисунок 1.8 - Рядок стану 
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1.1.2 Завдання параметрів креслення 

 

За замовченням команда New (Новий документ) викликає 

діалогове вікно Select Template (Вибір шаблона креслення) 

(рис. 1.9). У ньому необхідно вибрати шаблон acadiso.dwt. 

Якщо в процесі роботи треба змінити параметри креслення, або 

робота проводиться з версією AutoCAD, де майстер відсутній, то 

перед початком роботи слід задати необхідні параметри: 

Формат аркушу задається командою LIMITS, після чого 

вводяться координати лівого нижнього та правого верхнього кута. 

Границі формату аркушу можна побачити, якщо змінити значення 

системної змінної GRIDDISPLAY з 3 на 2. Сітка буде відображатися 

тільки у межах встановлених командою LIMITS. 

 

 
 

Рисунок 1.9 – Вигляд вікна Select Template (Вибір шаблона креслення) 

Стиль розмірів задається в закладці Annotate (Анотації). Для 

цього у розділі Dimensions (Розмір) необхідно натиснути кнопку з 

маленькою стрілкою, або у спадаючому списку стилів натиснути 

кнопку Manage Dimension Styles…, або ввести команду DIMSTYLE. 

Відкриється діалогове вікно Dimension Style Manager (рис. 1.10). 
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Рисунок 1.10 – Налаштування стилів розмірів 

Для модифікацій стилів розмірів треба натиснути кнопку Modify 

(Модифікація):  

- у вкладці Lines (Лінії) – стиль розмірних ліній та ліній 

винесення (рис. 1.11а); 

- у вкладці Symbols and Arrows (Символи та стрілки) - стиль 

та розмір стрілок (рис. 1.11б); 

- у вкладці Text (Текст) — висоту, стиль та позиціювання тексту  

(рис. 1.11в). 

 

   
А       Б       В 

Рисунок 1.11–Встановлення стилю розмірних ліній та ліній винесення 

Встановлення стилю та розмірів стрілок 

Встановлення стилю розмірного тексту  

Стиль тексту задається в закладці Annotate (Анотації). Для 

цього у розділі Text (Текст) необхідно натиснути кнопку з маленькою 

стрілкою, або у спадаючому списку стилів натиснути кнопку Manage 
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Text Styles…, або командою STYLE. Відкриється діалогове вікно Text 

Style (рис. 1.12). 

 

Рисунок 1.12 –Встановлення стилю тексту розмірів 

Далі можна задати: Style (Ім’я стилю), Font Name (Гарнітура 

шрифту), Font Style (Стиль шрифту), Height (Висота), необхідні 

ефекти – Upside down (Перевернутий), Backwards (Зворотній), 

Vertical (Зверху нагору), Oblique Angle (Кут нахилу). 

При роботі у середовищі AutoCAD 2016 для підвищення 

зручності можна використовувати екран потрібного кольору. 

Для зміни кольору слід натиснути кнопку додатка, де 

вибрати кнопку Options (Опції). У діалоговому вікні 

вибрати: Display (Екран) – Colors (Кольори), після чого 

задати фон робочого поля. В цьому ж діалоговому вікні можна 

змінити розмір курсора - Crosshair size (Розмір курсора) у відсотках 

від розміру екрана від 1% до 100%. 

 

1.1.3 Керування зображенням 

У правій частині робочого простору AutoCAD 2016 розташовані 

інструменти керування зображенням ViewCube та Navigation bar 

(рис. 1.13). 
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Рисунок 1.13 – Інструменти керування зображенням 

ViewCube призначений для зміни поточної проекції, для 

перегляду креслення під іншим кутом. 

Navigation bar дозволяє використовувати наступні інструменти: 

Full Navigation Wheel – спеціальний мульти-інструмент 

3D-навігації, призначений для досвідчених користувачів. 

Pan – панорамування зображення робочого простору у 

площині екрану, також здійснюється при утриманні середньої 

кнопки миші. Дозволяє переміщати зображення відносно екрана. 

Zoom – група інструментів масштабування зображення 

робочого простору: 

Orbit – обертання видів у тривимірному просторі. 

ShowMotion – інтерфейс створення презентаційних анімацій 

віртуальної камери. 

1.1.4 Системи координат 

Значення координат, незалежно від способу їх вводу, завжди 

пов’язані з системою координат. За замовчанням завжди 

використовується Word Coordinate System – WCS (Світова Система 

Координат). Вона визначена так: 0X – зліва направо, 0Y – знизу 

догори, 0Z – перпендикулярно екрану назовні. Для зручності роботи 

може бути прийнята User Coordinate System – UCS (Користувацька 

система координат), яку можна перемістити й повернути відносно 

світової. Для завдання користувацької системи координат слід 

скористатися командою UCS або викликати контекстне меню іконки 
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UCS (КСК). 
 

 

 e Вписати усі об’єкти 

кресленика у межі робочого 

простору 

(Показати 

рамкою) 
w Дозволяє масштабувати 

обрану прямокутну частину 

робочого простору 

(Попередній 

крок) 
p Попередній стан масштабу 

(Інтерактивний 

масштаб) 
r Динамічна зміна масштабу 

мишею 

(Все) a Вписати усі об’єкти 

кресленика та область задану 

командою limits у межі 

робочого простору 

(Динамічний 

масштаб 

рамкою) 

d Просунута динамічна зміна  

масштабу мишею 

(Масштаб) s Задати масштаб множником 

(Центр) c Масштабувати навколо 

вказаної точки зі вказаним 

множником 

(Об'єкт) o Масштабувати за обраними 

об'єктами 

 2x Двократне збільшення 

 0.5x Двократне зменшення 

1.1.5 Робота з шарами 

 

Для підвищення зручності роботи у AutoCAD 2016 існує 

поняття шарів. Кожен шар має свої властивості: колір, тип лінії, стилі 

та ін. При роботі зі складними кресленнями можна виключати деякі 

шари, робити їх неактивними. 

Рекомендується будувати у різних шарах: 
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 основні зображення кожного окремого виду (ім’я ВИД_N); 

 центрові лінії (ім’я ВІСЬОВІ); 

 допоміжні зображення, лінії побудови (ім’я ДОПОМІЖНІ); 

 розміри (ім’я РОЗМІРИ); 

 текстову інформацію (ім’я ТЕКСТ); 

 таблиці (ім’я ТАБЛИЦЯ_N); 

 рамку та штамп (ім'я РАМКА). 

Для кожного об'єкту слід задати тип, вагу та колір ліній у 

вкладці Home, розділі Properties (Властивості). 

Але більш зручно створити нові шари у вкладці Home, розділ 

Layers (Шари). 

 

 

Рисунок 1.14 – Діалогове вікно для створення шарів 

Для створення нових шарів слід вибрати команду  Layer 

(Шари), після чого з’являється діалогове вікно Layer  Properties 

Manager (Властивості шару та типу лінії) У цьому вікні можна 

створити новий шар (New), задати для нього ім’я, колір, тип лінії 

(рис. 1.15). 

Якщо лінії необхідного типу немає у списку, то її необхідно 

попередньо завантажити, для цього у вкладці Home розділі Properties 

(Властивості) у списку Linetype (Тип лінії) обрати Other. У 

діалоговому вікні, що з’явиться при цьому, слід обрати опцію Load 

(Завантажити) та обрати необхідні типи ліній. 
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Рисунок 1.15 – Діалогове вікно для створення шарів 

1.2 Порядок виконання роботи 

1.2.1 Запустити AutoCAD 2016. 

1.2.2 У Create New Drawing вибрати Use a Wizard - Quick 

Setup – Ok. Задати параметри: система одиниць – десяткова 

(Decimal), точність – 0,0000, розміри формату - 420, 297. Інші 

параметри задаються за умовчанням. 

1.2.4 Ввести з клавіатури команду grid та задати параметри сітки 

20. Ввести з клавіатури команду snap та задати параметри кроку 7. 

1.2.3 В рядку стану включити режими SNAP, GRID. Спробувати 

попасти курсором між точками сітки. Зробити висновки. 

1.2.5 В рядку стану включити режим ORTHO. Вибрати команду 

 LINE. Вибрати довільно положення першої точки відрізку, 

клікнути курсором на робочому полі. Спробувати накреслити похилу 

лінію (під кутом, відмінним від 0
о
 та 90

о
). Відмінити команду, 

натиснувши на клавішу Esc. Зробити висновки. 

1.2.6 Створити новий файл. При цьому попередній файл закрити 

без збереження.  

1.2.7 Задати вручну розміри формату аркушу за допомогою 

команди limits: 

lower left corner (нижній лівий кут) – 0,0; 

upper right corner (верхній правий кут) – 210,297. 

1.2.8 Включити сітку grid. 
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1.2.9 В рядку стану натиснути кнопку Object Snap, потім 

викликати її контекстне меню, в якому обрати пункт меню Settings. 

При цьому з’являється діалогове вікно Drafting Settings (Установки 

креслення) (рис. 1.13). Включити прив’язки за кінцевою точкою 

Endpoint (end of) та перетином Intersection (int of). 

1.2.10 За допомогою команди  layer створити нові шари: 

- шар “Головний” – колір білий, тип лінії – Continuous 

(Суцільна); 

- шар “Вісі” – колір помаранчевий, тип лінії – Center (штрих- 

пунктирна). 

- шар “Розміри” – колір синій, тип лінії – Continuous (суцільна) 

(рис. 1.16). 

 

Рисунок 1.16 – Вигляд закладки включення прив’язок 

1.2.11 Вибрати шар “вісі”. За допомогою команди XLINE з 

ключем h виконати горизонтальну вісь деталі. За допомогою команди 

XLINE з ключем v виконати вертикальну вісь у початку координат, 

наступну вертикальну вісь праворуч на 200 мм для побудови кола.  
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1.2.12 Вибрати шар “Головний”. У цьому шарі за допомогою 

команди  - circle (коло)  накреслити два кола з центрами (0,0) та 

діаметрами ∅92 та ∅140. На відстані 200 мм від попереднього центра 

праворуч побудувати два кола ∅40 та ∅80. Вигляд зображення 

наведений на рисунку 1.17. 

 

Рисунок 1.17 – Вигляд зображення 1 

1.2.13 За допомогою команди PLINE створити ламану. 

Координати наступних точок задавати за допомогою відносних 

координат. Після кожної координати слід натискати клавішу Enter або 

пробіл: 
200,40 @-80,0 @0,20 @-120,0 

 

Вигляд зображення наведений на рисунку 1.18. 

 

 

Рисунок 1.18 – Вигляд зображення 2 
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Альтернативно введення відносних координат можна виконати, 

використовуючи інтерактивне поле вводу (рис). В цьому випадку 

рекомендується також ввімкнути режим ORTHO. 

 

 

Рисунок 1.19 – Ортогональний режим 

1.2.14 Створити нижню частину виду за допомогою команди 

MIRROR. Для цього треба відмітити накреслений у попередньому 

пункті елемент (окрім осьових та кола) безпосередньо курсором або 

вибирати рамкою. Вісь симетрії вказати на горизонтальній вісі, обравши 

на ній дві довільні точки. Видаляти попередній об’єкт не треба (ключ 

N). Зображення повинне мати вигляд, наведений на рис. 1.23. 

 

 

Рисунок 1.23 – Вигляд зображення 3 

 

1.2.15 За допомогою команди TRIM (Обрізати) обрізаємо 

зайві контури креслення (частини кіл та поліліній). Спочатку 

необхідно виділити контури, якими обрізаємо, далі натиснути Enter та 

виділити зайві ділянки, які будуть видалені. Для обрізки осьових ліній 

накресліть два тимчасові кола з діаметрами на 10мм більше зовнішніх 

кіл з центрами на перетинах осьових ліній. Зображення повинне 

набути вигляду як на рисунку 1.24. 
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Рисунок 1.24 – Вигляд зображення 4 

Простановка розмірів 
1.2.16 Вибрати шар “Розміри”. Горизонтальні та вертикальні 

розміри проставте за допомогою команди DIMLINEAR (Лінійний), 

діаметри – DIMDIAMETER (Діаметральний), радіус – DIMRADIUS 

(Радіальний). 

Змініть стиль розмірів. На закладці Annotate (Анотації) у 

розділі Dimension (Розмір) натисніть кнопку з маленькою стрілкою. 

Задайте висоту тексту та розмір стрілки 7 мм. Встановіть 

вирівнювання тексту ISO standard. Також задайте нахил тексту 15º. 

 

У додатку А взяти індивідуальне завдання для самостійного 

креслення за варіантом. 

 

Рисунок 1.24 – Проставлені розміри 

 

1.3 Контрольні питання 

1.3.1 Які панелі знаходяться на екрані середовища 

AutoCAD2016? 

1.3.2 Який вміст стандартної панелі? 
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1.3.3 Що таке інструментальні панелі і для чого вони 

використовуються ? 

1.3.4 Що таке командний рядок? 

1.3.5 Які режими задаються за допомогою рядку стану? 

1.3.6 Що таке МАЙСТЕР і для чого він використовується? 

1.3.7 Як задати формат ? 

1.3.8 Як задати стиль розмірів? 

1.3.9 Як змінити колір екрана та параметри курсора? 

1.3.10 Які команди використовуються для керування 

зображенням екрана? 

1.3.11 Що таке система координат та які вони бувають? 

1.3.12 Як задати власну систему координат? 

1.3.13 Для чого використовуються шари? 

1.3.14 Як задати новий шар та його параметри? 

1.4 Зміст звіту 

 

1.4.1 Титульний лист; 

1.4.2 Мета роботи; 

1.4.3 Опис алгоритму креслення індивідуального завдання; 

1.4.4 Результат креслення. 
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2 ЛАБОРАТОРНА РОБОТА 2 

ОСНОВНІ КОМАНДИ AUTOCAD 

 

Мета роботи: вивчити основні прийоми створення примітивів та 

редагування зображення за допомогою робіт з каталогу LABS. 

 

2.1 Теоретичні відомості 

Кожен графічний об’єкт складається з сукупності елементарних 

частин – примітивів. До них відносяться: точки, відрізки, криві (в тому 

числі й дуги), кола та ін.  

Кожен примітив можна виконати декількома способами, вибір 

способу залежить від поставленої задачі. 

Для забезпечення необхідної точності слід використовувати 

введення примітивів за координатами, або прив’язки.  

Введення координат в AutoCAD можна здійснити двома 

способами: 

- безпосередньо з клавіатури, задаючи числові значення; 

- з використанням графічного маркера, який переміщується по 

екрану за допомогою вказування. 

Вводити координати з клавіатури можна у вигляді абсолютних 

та відносних координат. 

Ввід абсолютних координат можна виконати в наступних 

форматах: 

- прямокутних (декартових) координатах X, Y; 

- полярних координатах r<A, де r – радіус, A – кут від 

попередньої крапки. 

Відносні координати задають зміщення від останньої введеної 

точки. Формат запису значень координат може бути таким: @ dx, dy – 

для прямокутних, або @ r<A для полярних. 

Для виконання будь–якої дії використовуються команди. 

Ввід команд можна здійснити різними способами: набрати на 

клавіатурі, вибрати з меню або клікнути відповідну піктограму на 

панелі інструментів. Команда може бути введена тільки в той момент, 

коли в командному рядку присутнє запрошення до вводу 

Command:(Команда:). Для вводу команди з клавіатури треба набрати 

ім’я команди й натиснути <Enter>. Для деяких команд допускається 
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введення абревіатур. 

Нижче наведені основні команди для створення примітивів. Ці 

команди знаходяться в меню Draw (Рисування), або на 

інструментальній панелі Draw (Рисування). 

 - команда POINT (точка), 

 - команда XLINE (конструкційна пряма), 

 - команда LINE (відрізок), 

 - команда ARC (дуга), 

 - команда PLINE (полілінія), 

 - команда MLINE (м-лінія), 

 - команда CIRCLE (коло) 

 - команда ELLIPS (еліпс), 

 - команда POLYGON (багатокутник), 

 - команда RECTANG (прямокутник), 

 - команда SPLINE (сплайн), 

 - команда ВHATCH (штриховка замкненого контуру), 

 - команда MTEXT (мультитекст). 

Для забезпечення точності креслення при створенні складних 

об’єктів з примітивів використовуються прив’язки. Команди прив’язок 

знаходяться на інструментальній панелі Object Snap (Захват об’єкта). 

 - команда _END OF (кінцева крапка), 

 - команда _MID OF (середина), 

 - команда _INT OF (перетин) 

 - команда _APPINT OF (уявний перетин), 

 - команда _CEN OF (центр), 

 - команда _QUA OF (квадрант), 
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 - команда _TAN TO (дотик), 

 - команда _PER TO (нормаль), 

 - команда _NOD OF (вузол), 

 - команда _NEA TO (найближча точка). 

В процесі створення зображення виникає необхідність його 

редагування. 

Якщо зображення має декілька однакових за розмірами або 

формою елементів, то для зручності роботи можна викреслити один 

елемент, а інші створювати за допомогою копіювання, переносу, 

подоби, дзеркального відображення, обертання та ін. 

Часто при створенні креслень використовуються конструкційні 

(необмежені) лінії, частину яких потім треба видалити. Для цього 

можна використовувати команди обрізки, витягування, видалення. 

Ці та інші команди використовуються для редагування помилок 

креслення, оптимізації його вигляду. 

Нижче наведені основні команди для редагування зображення. 

Ці команди знаходяться в меню Modify (Модифікувати), або на 

інструментальних панелях Modify, Modify-2, (Модифікувати, 

Модифікувати-2). 

  - команда EXPLODE (руйнування блока); 

 - команда ERASE (знищити); 

 - команда MOVE (перенести); 

 - команда COPY (копіювати); 

 - команда ROTATE (обертання); 

 - команда SCALE (масштаб); 

 - команда MIRROR (дзеркальне відображення); 

 - команда OFFSET (подоба); 
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 - команда ARRAY (масив); 

 - команда STRETCH (розтяг); 

 - команда BREAK (розрив); 

 - команда TRIM (обрізати); 

 - команда EXTEND (подовжити); 

 - команда LENGTHEN (витягнути); 

 - команда FILLET (скругління); 

 - команда CHAMFER (фаска); 

 - команда EDIT (редагування полілінії); 

 - команда MLEDIT (редагування мультілінії); 

 - команда SRLINEDIT (редагування сплайну). 

Одним з важливих елементів при створенні креслень є 

простановка розмірів. Для цього використовуються спеціальні 

команди. Ці команди знаходяться в меню Dimension (Розмірність), 

або на інструментальній панелі Dimension (Розмірність). 

 - команда DIMLINEAR (лінійний розмір) , 

 - команда DIMALIGNED (паралельний розмір) , 

 - команда DIMBASELINE (базовий розмір) , 

 - команда DIMCONTINUE (розмірний ланцюг) , 

 - команда DIMANGULAR (кутовий розмір) , 

 - команда DIMDIAMETER (діаметр) , 
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 - команда DIMRADIUS (радіус) , 

 - команда DIMCENTER (центровий розмір) , 

 - команда DIMORDINATE (координата) , 

 - команда LEADER (виноска) , 

 - команда DDIM (стиль розмірів) , 

 - команда DIMEDIT (редагування розмірів) , 

 - команда DIMTEDIT (редагування тексту розміру) , 

 - команда DIMOVERRIDE (оновлення величини). 

 

2.2 Контрольні запитання 

2.2.1 Що таке примітив ? 
2.2.2 Як забезпечується точність креслення ? 
2.2.3 Які існують способи введення координат ? 
2.2.4 Як задаються абсолютні координати ? 
2.2.5 Що таке відносні координати та як вони задаються ? 
2.2.6 Як ввести команду в AutoCAD ? 
2.2.7 Які команди використовуються для створення примітивів ? 
2.2.8 Для чого використовуються команди захвата? 
2.2.9 Для чого використовується редагування зображення ? 
2.2.10 Які команди використовуються для копіювання ? 
2.2.11 Які команди використовуються для переміщення? 
2.2.12 Які команди використовуються для зміни розмірів? 
2.2.13 Які команди використовуються для фасок та скруглень? 
2.2.14 Які команди використовуються для знищення 

зображення?  
2.2.15 Які команди використовуються для редагування складних 

об’єктів?  
2.2.16 Які команди використовуються для простановки розмірів? 
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2.3 Порядок виконання роботи 

2.3.1 Виконати вправи з засвоєння команд креслення, 
редагування AutoCAD. Вправи знаходяться у папці LAB1, LAB2, 
LAB3 каталогу Labs. 

 

2.4 Зміст звіту 

2.4.1 Тема та мета роботи. 
2.4.2 Відповіді на контрольні запитання. 
2.4.3Стислі описи алгоритмів створення примітивів, 

простановки розмірів та редагування зображення. 
2.4.6 Виконані вправи за шаблонами каталогу Labs. 
2.4.7 Висновки з роботи. 
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3 ЛАБОРАТОРНА РОБОТА 3 

СТВОРЕННЯ ДВОВИМІРНИХ ЗОБРАЖЕНЬ У 

СЕРЕДОВИЩІ AUTOCAD 

 

Мета роботи: вивчити основні прийоми роботи в середовищі 

AutoCAD та отримати практичні навички з виконання двовимірних 

зображень за допомогою команд Draw (Рисувати) та Modify 

(Модифікувати), а також простановки розмірів за допомогою команд 

Dimension (Розміри). 

 

3.1 Теоретичні відомості 

 

Середовище AutoCAD найчастіше використовується для 

створення двовимірних креслень. Але перш, ніж виконувати 

креслення, слід спочатку створити зображення майбутньої деталі. Для 

цього використовуються команди креслення Draw (Рисувати) для 

створення так званого образа зображення та команди редагування 

Modify (Модифікувати) для доведення його до кінцевого стану. 

Для креслення найчастіше застосовуються команди: 

- команда XLINE  (конструкційна пряма) – для виконання 

осьових та допоміжних ліній, найчастіше використовуються v –

вертикальна, h – горизонтальна, o – подібна (на заданій дистанції), a – 

під заданим кутом; 

- команда LINE  (відрізок) – для виконання основних та 

допоміжних ліній. Положення відрізків задається за двома точками, 

при цьому положення початкової точки можна задавати абсолютними 

координатами, або за допомогою прив’язок до елементів існуючого 

зображення, положення кінцевої точки – аналогічно, або відносними 

координатами (відносно початкової точки); 

- команда PLINE  (полілінія) – аналогічна попередній 

команді, але вона дозволяє отримувати складне зображення з ряду 

відрізків, дуг, або сплайнів як єдиний об’єкт, при цьому для створення 

замкнених зображень замість координат точки, що замикає 
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зображення слід вводити с – замкнути. Крім того, ця команда 

дозволяє отримувати лінії заданої товщини (товщина може мінятися 

протягом ліній, що дозволяє отримувати, наприклад, стрілки); 

- команда SPLINE  (сплайн) – дозволяє отримувати довільні 

(непрямі) елементи зображення; 

- команди CIRCLE  (коло), ELLIPS  (еліпс), 

POLYGON  (багатокутник) описаний навколо кола с або 

уписаний у нього і, RECTANG  (прямокутник) дозволяють 

отримувати зображення відповідних елементів креслення; 

- команди TEXT (текст), MTEXT  (мультитекст), DTEXT 

 (політекст) дозволяють виконувати, відповідно, звичайний 

однолінійній текст (з завданням початкової точки, висоти шрифту, 

кута нахилу та стилю), багатолінійний текст (з завданням поля тексту, 

висота шрифту при цьому залежить від розмірів поля та об’єму 

напису), багатолінійний текст (з переносом рядків). 

Для редагування зображень найчастіше застосовуються 

команди: 

- команда COPY  (копіювати) – дозволяє скопіювати один 

або декілька елементів зображення та додати їх у будь – яке місце 

креслення. Початковий об’єкт при цьому зберігається. У діалозі треба 

задати: елементи об’єкта, які потрібно скопіювати, базову точку 

вставки (за якою об’єкт вставлятиметься на інше місце) та точку, в яку 

об’єкт вставлятиметься. Якщо у діалозі обрати Multiple (m), то за 

допомогою цієї команди об’єкт можна копіювати багато разів; 

- команда MOVE  (перенести) – діє аналогічно попередній 

команді, але об’єкт видаляється з початкового місця та переноситься у 

інше; 

- команда ROTATE  (обертання) – використовується для 

зміни положення елементів зображення; обертання виконується 

відносно обраної точки на заданий кут. Напрямки обертання: 

позитивний кут – проти годинної стрілки, від’ємний – поза. Напрямки 
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обертання можна змінити у Advanced Setup (Детальна підготовка) за 

допомогою МАЙСТРА; 

- команда MIRROR  (дзеркальне відображення) – дозволяє 
отримувати дзеркальне зображення одного або декількох елементів об’єкта, 
при цьому задаються координати осі обертання (безпосередньо або за 
допомогою прив’язок до елементів існуючого зображення). Команда 
завершується вибором опції Delete old objects (Видалити попередній 
об’єкт), на який за умовчанням можна відповісти N (ні). Якщо ж об’єкт 
треба видалити, слід набрати Y (так); 

- команда  OFFSET (подоба) – дуже зручна команда, якщо треба 
скопіювати зображення (в тому числі й складне) зі збільшенням або 
зменшенням масштабу. Цю команду можна використовувати також для 
копіювання відрізків ліній на задану дистанцію (аналогічно команді XLINE - 
o) та створення концентричних кіл. Задається об’єкт копіювання, дистанція, 
на яку треба скопіювати (відстань між рівнобіжними лініями зображень, для 
концентричних кіл - це різниця між радіусами) та напрямок копіювання; 

- команда ARRAY  (масив) дозволяє виконувати складне 
багаторазове копіювання об’єктів, якщо вони розташовані з постійною 
дистанцією лінійною (за горизонталлю, вертикаллю) або кутовою. 
Відповідно до цього масив буває прямокутний (Rectangular), або полярний 
(Polar). Під час виклику цієї команди з’являється діалогове вікно, у якому 
слід задати: вид масива, дистанцію копіювання. 

Вид діалогових вікон роботи з масивами наведений на рис. 3.1, 3.2. 
При роботі з прямокутним масивом (Rectangular Array) слід задати 

кількість копій за рядками (Rows) та стовбцями (Colums), дистанції між 
копіями у рядках та стовбцях, а також кут оберту усього масиву при 
копіюванні (Angle of array). Після цього слід вказати об’єкт копіювання 
(Select objects) (рис. 5.1). 

При роботі з полярним масивом (Rectangular Array) слід задати 
координати центральної точки (полюса). Кількість копій можна задавати 

декількома методами. Якщо обрати Total number of items  Angle to fill, то 
задається загальна кількість ітерацій та загальний кут масива. Якщо обрати 

Total number of items  Angle between items, то задається загальна кількість 

ітерацій та кут між ітераціями. Якщо обрати Angle to fill  Angle between 
items, то задається загальній кут масива та кут між окремими ітераціями. 
Включена опція Rotate items as copied дозволяє обертати копію відносно 
полюса. Після цього слід вказати об’єкт копіювання (Select objects) (рис. 
3.2). 
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Рисунок 3.1 – Діалогове вікно завдання параметрів прямокутного 

масиву. 

 

 

Рисунок 3.2 – Діалогове вікно завдання параметрів полярного масиву. 

- команда TRIM  (вирівняти, обрізати) дозволяє обрізати 

залишки ліній зображення, використовується дуже часто. У діалозі 

слід по-перше задати лінії, за допомогою яких буде проводитись 

відрізка, а потім – лінії, які треба відрізати; 

- команда EXTEND  (витягнути) дозволяє дотягнути лінію 

до заданої лінії або контуру. У діалозі слід по-перше задати лінії 
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(контури), до яких слід витягувати, а потім – лінії, які треба 

витягнути; 

- команда FILLET  (скруглення) дозволяє отримати 

скруглення заданого радіуса між лініями, що перетинаються. Якщо 

радіус скруглення відрізняється від встановленого за змовчанням, то в 

діалозі слід спочатку задати його, обравши Radius r. Крім того, можна 

попередньо задати Trim (відрізати) або Nо trim (не відрізати). В 

першому випадку частини ліній поза скругленням будуть видалені, у 

другому – ні. Після цього слід задати дві лінії перетину, між якими 

виконується скруглення; 

- команда CHAMFER  (фаска) дозволяє отримати фаску 

заданого розміру між лініями, що перетинаються. В діалозі можна 

задати: проекції фаски на горизонталь та вертикаль d або кут фаски а 

(при цьому спочатку задається проекція на горизонталь, потім кут). 

Тут також можна попередньо задати Trim (відрізати) або Nо trim (не 

відрізати). Аналогічно попередній команді після завдання параметрів 

фаски слід задати дві лінії перетину, між якими вона виконується; 

- команда EXPLODE  (руйнування блока) 

використовується, якщо потрібно редагувати суцільний об’єкт 

(наприклад, створений за допомогою команди PLINE, або раніше 

створений блок). В цьому випадку редагування елементів неможливе, 

необхідно обрати команду та об’єкт руйнування, після чого він 

розпадається на окремі елементи; 

- команда ERASE  (знищити) використовується для 

видалення елементів зображення аналогічно кнопці Delete на 

клавіатурі; 

- команда BHATCH  (штриховка) дозволяє 

отримувати разні види штриховки замкнених контурів за 

допомогою шаблонів або паралельними лініями з заданими 

дистанцією та кутом нахилу. Після виклику команди з’являється 

діалогове вікно, вид якого наведений на рис. 3.3. 
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Рисунок 3.3 – Діалогове вікно параметрів штриховки 

 

У цьому вікні можна обрати тип штриховки (за шаблоном – 

Predifined, або користувальницьку – User defined), задати тип 

шаблона, кут оберту, масштаб, для користувальницької – дистанцію 

між лініями та її вигляд – одиночна або подвійна (Double). На закладці 

Advanced (рис. 3.4) можна вибрати варіант штрихування декількох 

замкнених контурів. Задавши параметри, слід обрати об’єкт 

штриховки (замкнений контур) точкою усередині контура, або 

рамкою. 

Після створення зображень видів деталі слід проставити її 

розміри. Для цього слід використовувати команди з інструментальної 

панелі Dimension (Величини). 

Найчастіше використовувані команди, що застосовуються для 

простановки розмірів: 
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Рисунок 3.4 – Діалогове вікно штриховки декількох замкнених 

контурів 

- команда DIMLINEAR  (лінійний розмір) для 

простановки розмірів лінійних горизонтальних та вертикальних 

поверхонь; 

- команда DIMALIGNED  (паралельний розмір) для 

простановки розмірів довільних поверхонь; 

- команда DIMANGULAR  (кутовий розмір) для 

простановки розмірів кутів; 

- команда DIMDIAMETER  (діаметр) для простановки 

діаметрів (тільки на колах); 

- команда DIMRADIUS  (радіальний розмір) для 

простановки радіусів дуг. 
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Якщо розміри задаються від однієї бази, можна використовувати 

команду DIMBASELINE  (базовий розмір) , якщо ланцюжком - 

DIMCONTINUE  (розмірний ланцюг). 

Для створення виносних елементів на цій же панелі передбачена 

команда LEADER  (виноска). 

Перед початком простановки розмірів слід попередньо задати їх 

стиль. 

Різні елементи зображень рекомендується виконувати у різних 

шарах. Методика завдання стилю розмірів, створення нових шарів та 

задання їх параметрів розглянута у лабораторній роботі №1. Так, слід 

виконувати у різних шарах лінії основного контура, допоміжні, осьові, 

розмірні, написи, штриховку, тощо. Крім того, можна створювати у 

різних шарах різні види деталі. 

При виконанні зображень зручно використовувати 

користувальницьку систему координат. Ця команда має вигляд USC 

або викликається зі стандартного меню  - о. Після цього можна 

задати будь - яку точку креслення як початок координат. Найзручніше 

задавати початок координат у перетинах осьових ліній, будь – якому 

куті зображення, тощо. 

Примітка. Користувальницьку систему координат можна 

багаторазово міняти протягом роботи. 

 

3.2 Контрольні запитання 

3.2.1 Назвіть основні команди креслення. 
3.2.2 Для чого використовується команда XLINE? 
3.2.3 Як можна задати положення відрізку? 
3.2.4 Чим відрізняється команда PLINE від команди LINE? 
3.2.5 Як слід завершувати замкнений контур? 
3.2.6 За допомогою якої команди можна створити стрілку? 
3.2.7 Що дозволяє користувальницька система координат? 
3.2.8 Назвіть основні команди редагування зображень. 
3.2.9 За допомогою яких команд можна скопіювати зображення? 

Яка між ними різниця? 
3.2.10 Для чого використовується команда ROTATE? 
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3.2.11 Для чого використовується команда OFFSET? 
3.2.12 Як створити масив зображення. Види масивів. 
3.2.13 Як видалити зайве зображення або його частину? 
3.2.14 Для чого використовується команда EXTEND? 
3.2.15 Як задати параметри скруглення? 
3.2.16 Як задати параметри фаски? 
3.2.17 Як виконати штриховку зображення? 
3.2.18 Як редагувати елементи складного об’єкта? 
3.2.19 Які існують команди простановки розмірів та для чого 

використовуються у AutoCAD? 
3.2.20 Як проставити базові розміри? 
3.2.21 Як проставити розміри ланцюжком? 
3.2.22 Як виконуються виноски? 

3.3 Порядок виконання роботи 

3.3.1 Запустити AutoCAD. 
3.3.2 Створити новий файл. 
Підготовка до роботи 
3.3.3 Настройки файла (за допомогою швидкої підготовки майстра – 

Wizards – Quick Setup, або вручну з команд меню Format): 
- одиниці вимірювання – децимальні (Decimal); 
- розмір креслення - 250 x 100; 
3.3.3 За допомогою команд меню Format задати стилі: 
- текста – Text style – тип шрифта (Font Name) GOST typeA (за 

наявності), або Arial Cyr – висота (Height) 7; 
- розмірів - Dimension style. В ньому виконати настройки згідно з 

рис. 3.5, 3.6. Точність (Primary Units – Precision) – 0,0. 
3.3.4 Завантажити тип лінії - центрова, для чого з меню Format 

викликати діалогове вікно Linetype, в ньому натиснути закладку Load, 

після чого знайти у діалоговому вікні Load of Reload Linetypes потрібну 

лінію (Center) та натиснути ОК. 

3.3.5 Створити нові шари: 

-“осн”, колір червоний, тип лінії Continuous, товщина – 0,5mm; 

- “вісі”, колір жовтий, тип лінії Center, товщина – Default; 

-“розм”, колір блакитний, тип лінії Continuous, товщина – 

Default; 

-“написи”, колір бузковий, тип лінії Continuous, товщина – 

0,2mm; 
-“штрих”, колір зелений, тип лінії Continuous, товщина – 

Default. 
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Рисунок 3.5 – Завдання стилю розмірних ліній та стрілок 

 

 

Рисунок 3.6 – Завдання стилю розмірного текста 
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Створення основи креслення 
3.3.6 Вибрати шар “вісі”. За допомогою команди XLINE – h 

виконати горизонтальну вісь деталі. 

3.3.7 Включити прив’язки (Osnap – Settings): _END OF 

(кінцева точка), _MID OF (середина), _CEN OF (центр), _INT OF 

(перетин), _NEA TO (найближча точка). 

3.3.8 Вибрати шар “осн”. За допомогою команди PLINE 

створити образ головного виду вала. Координату початкової точки 

вибрати на осьовій лінії ближче до лівого боку робочого екрану. 

Координати наступних точок задавати за допомогою відносних 

координат. Після кожної координати слід натискати клавішу Enter: 

@10<90; @20<0; @15<90; @5<0; @15<-90; @30<0; @5<90; 

@15<0; @10<-90; @30<0; @5<-90 

Отримане зображення повинно мати вигляд, що наведений на 

рис. 3.7. 

3.3.9 Вибрати шар “вісі”. За допомогою команди XLINE – o 

виконати вертикальну вісь деталі на дистанції 10 від правої поверхні 

фланця вала. За допомогою команди XLINE – v виконати вертикальну 

вісь праворуч від головного виду для побудови виду справа (виду А). 

Вигляд зображення наведений на рисунку 3.8. 

 

Рисунок 3.7 – Вигляд зображення 1 
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Рисунок 3.8 – Вигляд зображення 2 

 

3.3.10 Вибрати шар “осн”. За допомогою команди CIRCLE 
виконати коло радіусом 2,5 на головному виді з центром за перетином 
осьових ліній. Виконати два кола: радіусом 25 та 15 праворуч від 
попереднього зображення (для створення виду А деталі) з центром за 
перетином осьових ліній. Вибрати шар “вісі”. Виконати допоміжне 
коло: радіусом 20 на виді А з центром за перетином осьових ліній. 
Вибрати шар “осн”. Виконати коло радіусом 3 на виді А з центром за 
перетином горизонтальної осі та допоміжного кола. Вигляд 
зображення наведений на рисунку 3.9. 

3.3.11 За допомогою команди POLYGON виконати на виді А 

квадрат 4 з центром за перетином осьових ліній, що вписаний – с - у 

коло радіусом 5. За допомогою команди CIRCLE виконати коло 

радіусом 2 на виді А з центром за перетином осьових ліній. 

3.3.12 Вибрати шар “Написи”. За допомогою команди PLINE 

виконати стрілку праворуч від головного виду. Прив’язку початкової 

точки дати на осьовій лінії. Напрямок стрілки – до головного виду. 

Довжину елементів стрілки обрати довільно, а ширину – w – задавати 

для першої ділянки Starting width – 1, Ending width – 1, для другої 

ділянки Starting width – 4, Ending width – 0. 

3.3.13 Вибрати шар “написи”. За допомогою команди TEXT 

написати над стрілкою літеру А, а над видом А – Вид А. При 

виконанні цієї команди рекомендується відключити прив’язки. 

Кінцеве зображення повинно мати вигляд, наведений на 

рис.3.10. 
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Рисунок 3.9 – Вигляд зображення 3 

 

Рисунок 3.10 – Кінцеве зображення 

Редагування креслення 
3.3.14 За допомогою рамки збільшити вид А. 

3.3.15 За допомогою команди ARRAY – polar скопіювати коло 

радіуса 3. Центр масиву (Center point) - у центрі виду (на перетині 

осьових), кількість елементів Total number of items - 8, кут обертання 

Angle to fill – 360. Оскільки копіюється коло, то опція Rotate items as 

copied (Повертати об’єкт при копіюванні) може бути відключена. 

3.3.16 За допомогою команди ROTATE повернути квадрат на 

кут 45 градусів відносно центра виду. 

3.3.17 За допомогою команди OFFSET отримати концентричне 

коло радіуса 3 у центрі виду. При цьому задати дистанцію Through 1, 

елементом копіювання обрати коло радіусом 2 та бік копіювання Side 

to offset – поза колом. 

3.3.18 За допомогою команди TRIM відрізати чверть створеного 

кола. Лініями відрізки обрати осьові. Вид А повинен мати вигляд, 

наведений на рисунку 3.11. 
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Рисунок 3.11 – Вигляд виду А 

3.3.19 Вибрати повне зображення за допомогою команди 

ZOOM_ALL. 

3.3.20 За допомогою команди EXPLODE підірвати суцільне 

зображення на головному виді. 

3.3.21 Провести горизонтальну конструкційну лінію XLINE h з 

захватом у верхньому куті квадрата на виді А. Обрати команду 

EXTEND, як лінію вирівнювання обрати знов створену горизонтальну 

лінію та витягнути до неї правий вертикальний відрізок на головному 

виді. За допомогою команди LINE провести горизонтальний відрізок 

поверх створеної лінії. Відрізок повинен з’єднувати точки перетину 

створеної горизонтальної лінії з двома крайніми правими 

вертикальними відрізками на головному виді. Видалити нижній 

горизонтальний відрізок (що був створений на попередньому етапі) за 

допомогою команди ERASE або кнопки Delete. За допомогою 

команди TRIM відрізати зайву частину вертикального відрізку, лінія 

відрізки - створена горизонталь. Після цього видалити цю 

горизонталь. В результаті отримаємо зображення, подібне до 

попереднього, але горизонтальний відрізок головного виду, що 

відповідає верхньому куту поверненого квадрата на виді А зміщений 

угору відповідно до попередніх змін. 

3.3.22 Далі працюємо з головним видом. 

3.3.23 Зробити фаску з параметрами d 2, 2 (або а 2, 45, t) та 

скругління радіусом r 3 за допомогою команд CHAMFER та FILLET. 

Зображення повинне мати вигляд, наведений на рисунку 3.12. 
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Рисунок 3.12 – Головний вид. Перший етап редагування 

 

3.3.24 За допомогою команди EXTEND витягнути вертикальні 

лінії до осьової. Вертикальні лінії, що сполучаються з фаскою та 

скругленням, накреслити за допомогою команди LINE, 

використовуючи захват за перетином _INT OF (початкова точка) та 

перпендикуляром до осьової _PER TO (кінцева точка). Якщо 

прив’язка _PER TO не включена, обрати її з відповідної 

інструментальної панелі або ввести з командного рядка. 

3.3.25 Створити нижню частину виду за допомогою команди 

MIRROR. Відмітити всі елементи головного виду окрім осьових та 

кола (безпосередньо відмічати курсором або вибирати рамкою). Вісь 

симетрії сполучити з горизонтальною віссю (обравши на ній дві 

довільні точки). Видаляти попередній об’єкт не треба (n). Зображення 

повинне мати вигляд, наведений на рисунку 5.13. 

3.3.26 Створити вертикальну вісь за допомогою команди XLINE 

о, подібну до попередньої вертикалі на дистанції 10. Шар – “вісі”. 

3.3.27 Скопіювати коло радіусом 2,5 за допомогою команди 

COPY. Коло вставити в перетин горизонтальної та знову створеної 

вертикальної осей. 

3.3.28 Послідовно викликаючи команду OFFSET, скопіювати 

правий верхній вертикальний відрізок ліворуч на дистанції: 1, 15, 17. 

Після кожного копіювання команду слід викликати знов та міняти 

дистанцію. 

3.3.29 Вибрати повне зображення за допомогою команди 

ZOOM_ALL. Вибрати шар “осн”. Провести дві горизонтальні 

конструкційні лінії XLINE h з захватом у верхній точці перетину 

концентричних кіл з вертикальною віссю на виді А. Повернутись до 

зображення головного виду (за допомогою рамки) та на основі  
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Рисунок 3.13 – Головний вид. Другий етап редагування 

 

створених допоміжних ліній зробити зображення різьбового 

отвору за допомогою команди LINE. Для вертикальної лінії 

обмеження отвору слід змінити товщину до 1mm. Захват обирати за 

перетином з відповідними допоміжними лініями. По закінченні 

креслення допоміжні лінії видалити. Зображення повинне мати вигляд, 

наведений на рисунку 3.14. 

3.3.30 Створити нижню частину різьбового отвору за допомогою 

команди MIRROR. Відмітити елементи отвору рамкою. Вісь симетрії 

сполучити з горизонтальною віссю (обравши на ній дві довільні 

точки). Видаляти попередній об’єкт не треба (n). 

3.3.31 За допомогою команди SPLINE накреслити довільну 

лінію ліворуч від різьбового отвору. Ця лінія є границею місцевого 

розрізу. 

3.3.32 Вибрати шар “штрих”. За допомогою команди BHATCH 

(Штриховка) обрати шаблон ANSI31, масштаб 1, кут 0 (цей кут 

обертає вже обраний шаблон). На зображенні вибрати дві точки (у 

верхній та нижній частині за межами різьбового отвору), після чого 

завершити команду. 

3.3.33 Вибрати повне зображення за допомогою команди 

ZOOM_ALL. За допомогою команди RECTANG виконати два 

прямокутники у будь – якому шарі. Ці прямокутники слід 

використовувати для обрізки осьових ліній. Після обрізки отримаємо 

кінцеве зображення валу, що наведене на рис. 3.15. 
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Рисунок 3.14 – Головний вид. Третій етап редагування 

 
Рисунок 3.15 – Креслення валу 

 

Простановка розмірів 
3.3.34 Вибрати шар “розм”. На головному виді проставити 

горизонтальний розмір 20 (від лівого боку вала) за допомогою 

команди DIMLINEAR. Обрати команду DIMCONTINUE та 

проставити розміри 5 та 30 (початок розмірного ланцюга – розмір 20). 

Аналогічно проставити відстані між отворами (10, 10). Проставити 

лінійний горизонтальній розмір 15 (від правого боку вала), а розмір 30 

проставити за допомогою команди DIMBASELINE від тієї ж бази. 
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3.3.35 Аналогічним чином проставити інші розміри. Діаметри 

кіл проставляти за допомогою команди DIMDIAMETER, радіус 

скруглення – DIMRADIUS, розмір квадрата – DIMALIGNED. 

Для циліндричних поверхонь на головному виді неможливо 

задати розміри як діаметральні (оскільки вони не є кола), тому для них 

після простановки слід відкоригувати запис, обравши для кожного 

розміру команду dimedit – New (Новий) – Symbol (Символ), де 

обрати знак діаметра, після чого ввести значення діаметра вручну. 

Аналогічно можна зробити написи при простановці фасок та кількості 

отворів. 

Після простановки розмірів зображення валу має вигляд, який 

наведено на рис. 3.16. 

 

 
Рисунок 3.16 – Креслення валу з розмірами 

 

5.3.36 Зберегти файл у власній папці з ім’ям Val_model. 

5.3.37 Закрити AutoCAD. 

3.4 Зміст звіту 

3.4.1 Тема та мета роботи. 

3.4.2 Відповіді на контрольні запитання. 

3.4.3 Алгоритм етапів виконання креслення з описом команд. 

3.4.4 Висновки з роботи. 
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4 ЛАБОРАТОРНА РОБОТА 4  

СТВОРЕННЯ РОБОЧОГО КРЕСЛЕННЯ В 

СЕРЕДОВИЩІ AUTOCAD 

Мета роботи: ознайомитись з особливостями створення 

двовимірних креслень; вивчити прийоми роботи з блоками; 

ознайомитись з різновидами команд введення та редагування текстів. 

4.1 Теоретичні відомості 

4.1.1 Створення шаблона 

Робочі креслення виконуються у відповідності з державними 

стандартами на листах визначених форматів, що містять рамку та 

штамп. Існує ряд основних та проміжних форматів (А4, А3, А2, А1, 

А0, А3х2 і.т.і.). 

При роботі з двовимірними кресленнями рекомендується 

створити попередньо креслення – шаблон потрібного формату, на 

якому виконати відповідні рамку та штамп і зберегти його з 

розширенням *.dwt (шаблон) для подальшого використання. 

AutoCAD дозволяє моделювати зображення у просторі моделі 

(Model), а компонувати креслення у просторі листа (Paper). Для 

переходу з одного простора в інший використовуються кнопки, 

розташовані в одному рядку з лінійкою горизонтальної прокрутки 

(рис. 4.1). 

 

Рисунок 4.1 – Кнопки переходу з простору моделі в простір листа 

Простір листа пов’язаний з пристроєм друку (принтером), тому 

під час переходу до нього з’являється діалогове вікно настройки 

принтера. У ньому можна задавати формат, на якому буде друкуватися 

креслення. Викликати це діалогове вікно можна також за допомогою 

команди меню File – Page Setup.  

 

4.1.2 Робота з блоками 

Якщо під час роботи виникає необхідність переміщати або 

копіювати складні зображення, їх зручніше об’єднати у єдине ціле, так 

званий блок (block). 

Для створення блока використовується команда  - МBLOCK 
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(створення блока), яка дозволяє викликати діалогове вікно для 

завдання параметрів майбутнього блока. Вигляд діалогового вікна 

наведений на рис. 4.2. 

 

Рисунок 4.2 – Вигляд діалогового вікна створення блока 
У цьому вікні слід: 
- задати ім’я блока, 
- обрати Base Point (Базова точка), та задати її координатами 

або точкою на зображенні майбутнього блока, 
- обрати Select Objects (Обрати об’єкт), після чого за 

допомогою рамки задати частину зображення, з якої формується блок. 
Якщо зображення повинно залишитись, опція Delete повинна 

бути відключена. Її включають, якщо зображення необхідно видалити 
та зберігати в майбутньому тільки як блок (наприклад, якщо це 
зображення не буде використовуватись у даному файлі, а вставлятись 
кожного разу у новий файл). 

Для вставки блока використовується команда INSERT 

(вставка блока), після виклику якої з’являється діалогове вікно для 

завдання параметрів вставки блока. 

Вигляд діалогового вікна наведено на рис. 4.3. 
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Рисунок 4.3 – Вигляд діалогового вікна вставки блока 
У цьому вікні слід: 
- задати ім’я блока, який потрібно вставити (цей блок повинен 

бути створений раніше у цьому ж файлі), 
- задати точку вставки, масштаб та кут обертання. 
Блок буде вставлений за допомогою його базової точки (яка була 

обрана при його створенні). 

Якщо включити опцію Explode, то після вставки блок буде 

розруйнований (тобто розпадеться на окремі зображення). Вихідний 

блок при цьому зберігається цільним. Це дозволяє відразу ж 

редагувати елементи вставленого блока. Якщо опція Explode не була 

включена, блок для редагування можна підірвати за допомогою 

команди  EXPLODE (руйнувати). 

Якщо блок потрібно вставляти у інші файли, його слід зберегти 

у файлі. Для цього використовується команда WBLOCK. 

Спочатку слід створити блок у новому чи вже існуючому файлі. 

Ім’я цього файла не повинно збігатися з ім’ям майбутнього блока. 

Після введення команди WBLOCK з’являється діалогове вікно для 

збереження файлу з блоком (рис. 6.4). У цьому вікні можна вибрати 

необхідний для збереження блок, задати його ім’я та папку, у якій 

його слід зберегти. Файл слід зберігати з тим же ім’ям, що й ім’я 

самого блока. 

Під час вставки блока слід за допомогою кнопки Browse знайти 
папку, у якій він зберігається. 
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Рисунок 4.4 – Вигляд діалогового вікна збереження блока 

 

4.1.3 Робота з текстом 

Текстову інформацію у АutoCAD можна вводити за допомогою 

декількох команд. 

 - команда MTEXT (мультитекст) дозволяє вводити текст 

багаторядковий, при цьому у діалозі задаються координати 

протилежних кутів прямокутника, у якому буде знаходитися 

майбутній текст, далі вводяться параметри тексту та його вміст. 

Цю команду зручно використовувати, якщо треба текст вмістити 

у задане поле (наприклад, при заповненні таблиць). 

 команда DTEXT (політекст) дозволяє вводити текст 

рядками з переносом. При цьому задається початкова точка, (можна 

також задати попередньо стиль тексту), висота, кут написання, після 

чого вводиться сам текст. Рядки відділяються один від одного за 

допомогою <Enter>. 

Цю команду зручно використовувати, якщо треба вводити 

багаторядковий текст (наприклад, при заповненні технічних вимог на 
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полі креслення). 

Команда TEXT (текст), дозволяє вводити звичайний лінійний 

текст (однорядковий). При цьому задається початкова точка (можна 

також задати попередньо стиль тексту), висота, кут написання, після 

чого вводиться сам текст. Цю команду зручно використовувати, якщо 

треба вводити однорядковий текст (наприклад, при виконанні окремих 

написів біля елементів креслення, заповненні штампу). 

4.2 Контрольні запитання 

4.2.1 Що таке простір моделі та простір листа? Для чого вони 
використовуються? 

4.2.2 Що таке блок та для чого він створюється? Приведіть 
команду та алгоритм створення блока? 

4.2.3 Яка команда використовується для вставки блоків? 
4.2.4 Як записати блок у файл? 
4.2.5 Як вставити блок з файлу? 
4.2.6 Які команди існують для створення тексту? Для чого вони 

використовуються? 

4.3 Порядок виконання роботи 

4.3.1 Запустити AutoCAD 2000. 

4.3.2 Створити новий файл. Формат – А3 горизонтальний 

(розміри – 420х297). 
4.3.3 За допомогою команд меню Format задати стилі: 
- текста – Text style – New – style1 – тип шрифта (Font Name) 

GOST typeA (за наявності), або Arial Cyr – висота (Height) 5; 
- розмірів - Dimension style – New – style1. В ньому виконати 

настройки згідно з рис. 5.5, 5.6. Точність (Primary Units – Precision) – 0,0. 

4.3.4 Створити нові шари з іменами “штамп”, колір білий, тип 

тип лінії Continuous, товщина – Default; “написи”, колір бузковий, 

тип лінії Continuous, товщина – 0,2mm. 

4.3.5 Зробити активним шар “штамп” та виконати у ньому 

зображення рамки (поля: ліве – 20 мм, інші – 5 мм) та основного 

штампа згідно з рис. 4.5. 

У лівому верхньому куті виконати маленький штамп розміром 

70х14 мм. 

4.3.6 Зберегти файл як шаблон з розширенням *.dwt. згідно з 

рис. 4.6. Дати файлу – шаблону ім’я FA3 (формат А3), після чого 

закрити файл. 
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Рисунок 4.5 – Основний штамп креслення 

 

Рисунок 4.6 – Збереження шаблона 

4.3.7 Відкрити файл Val_model з попередньої роботи. 

4.3.8 За допомогою команди Мblock зробити з зображення вала 

блок з іменем “Val_N”, де N – номер варіанта студента. Базовою 

точкою вибрати точку, за якою блок буде зручніше вставляти, 

наприклад, лівий нижній кут головного вида. 

4.3.9 За допомогою команди wblock зберегти блок у файлі з тим 

же іменем. 

4.3.10 Закрити файл Val_model зі збереженням. 

4.3.11 Створити новий файл на базі шаблона FA3. 

4.3.12 Дозаповнити штамп за допомогою команди text. Стиль 

шрифту обирається за змовчанням (style 1). У верхньому кутовому 

штампі (розміром 70х14 мм) ввести децимальний номер деталі, 

вказавши кут обертання текста (Specify rotation angle of text) – 180
о
. 

Для вала децимальний номер – ГКІЮ.715134.000. 
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4.3.13 Вставити у новий файл блок з зображенням валу Val_N за 

допомогою команди insert. При цьому розмістити зображення таким 

чином, щоб залишалось місце над штампом для запису технічних 

вимог. За потреби можна змінити масштаб. 

4.3.14 Ввести текст технічних вимог: 

1. HRCэ 38…42 

2. Покриття Ц6.хр 

3. Інші технічні вимоги – за ОСТ4ГО.070.014 

При введенні тексту використовувати команду MTEXT або 

DTEXT. 
Технічні вимоги вводити над штампом таким чином, щоб 

відстань до штампу була не менш 15 мм. 

4.3.15 Накреслити знак шорсткості за допомогою команд line 

або pline. Вигляд знаку наведений на рисунку 6.7. Висота знаку h 

дорівнює висоті цифр розмірів. Н дорівнює 1,5…3,0 h. 

 

 

 

 

Рисунок 6.7 – Знак шорсткості 

4.3.16 Створити з цього зображення блок з ім’ям s та зберегти у файлі. 

4.3.17 Вставити знак шорсткості у верхній правий кут креслення 

двічі – у масштабі 1 та 0,9. Над першим знаком написати Rz40, другий 

помістити у дужки. Вигляд зображення – на рисунку 4.8. 

 
Рисунок 4.8 – Вигляд простановки шорсткості на кресленні 

Остаточний вигляд креслення вала наведено на рис. 6.9.  

4.3.18 Виконати креслення деталі за вказівкою викладача. 

4.4 Зміст звіту 

4.4.1 Тема та мета роботи. 

4.4.2 Відповіді на контрольні запитання. 

4.4.3 Алгоритми етапів виконання креслень деталей з описом 

команд. 

4.4.4 Висновки з роботи. 

h 
H 
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Рисунок 4.9 – Креслення вала 
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5 ЛАБОРАТОРНА РОБОТА №5 

СТВОРЕННЯ 3D-МОДЕЛЕЙ У СЕРЕДОВИЩІ 

AUTOCAD  

Мета роботи: отримати практичні навички з побудови 

просторових моделей у середовищі AutoCAD. 

5.1 Теоретичні відомості 

5.1.1 Створення креслення-прототипу (шаблону) 

Для документів креслень, що містять 3D-моделі, варто 

створювати шаблони, у яких крім традиційних атрибутів для плоского 

креслення встановлюється ряд атрибутів для формування і візуалізації 

просторових моделей. 

Для створення шаблону слід спочатку створити нове креслення 

та задати у ньому усі необхідні налаштування, після чого зберегти 

його з розширенням *.dwt (шаблон). 

Налаштування, притаманні як для двовимірних, так і для 

просторових креслень: 
- система вимірювань та границі креслення; 

- стилі розмірів, точок, тексту; 

- параметри екрану (колір екрана, завдання кроків сітки і 

переміщення курсору, масштаб зображення); 

- потрібні прив’язки; 

- завантаження додаткових типів ліній та створення потрібних 

шарів; 

- системи координат користувача. 

Налаштування, притаманні кресленням просторових 

моделей: 
- визначення просторової системи координат; 

- багатоекранна конфігурація; 

- напрямок погляду; 

- параметри сторінки та друкуючого пристрою у просторі листа. 

Визначення параметрів системи координат: виконується за 

допомогою команди UCS. Вона дозволяє створювати систему 

координат користувача (СКК) та переходити між нею та світовою 

системою координат (ССК). 

При роботі з просторовими об'єктами доцільно додатково визначити 

систему координат, у якій вісі X і Y спрямовані протилежно одноіменним 

вісям світової системи координат, а напрямок вісі Z лишається незмінним. 

При роботі з просторовими об'єктами слід також задавати: 
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- точку зору; 

- напрямок погляду; 

- масштаб зображення. 

Точка зору при ортогональному способі проектування 

встановлюється командою VPOINT. На запит команди слід ввести 

координати початку вектора проектування (його кінець збігається з 

початком системи координат). За замовчуванням точка зору 

визначається координатами 0,0,1 відносно світової системи 

координат.  

Вектор напрямку погляду за замовчуванням визначається 

щодо світової системи координат (WORLDVIEW 1). Якщо 

встановити значення змінної WORLDVIEW 0, то вектор напрямку 

погляду буде визначатися щодо поточної системи координат. 

Масштаб зображення на екрані або у кожному вікні можна 

змінювати за допомогою команди ZOOM. 

Багатовіконна конфігурація є зручною для просторового 

моделювання, але не дає можливості компонувати технічне креслення 

з декількох видів просторової моделі. Такі можливості надаються в 

просторі листа (Paper space). Для переходу в простір листа у рядку 

під кресленням слід натиснути закладку Layout1 та зробити у ньому 

відповідні настройки. 

 

5.1.2 Формування 3D-моделі 

У системі AutoCAD можна формувати наступні види моделей: 

- каркасна модель; 

- поверхнева модель; 

- твердотільна модель. 

У каркасній моделі є тільки краї (лінії перетинання) поверхонь 

об'єкта. Сьогодні таке моделювання практично не використовується і 

його варто застосовувати лише для моделювання будь - яких 

просторових схем, наприклад електропроводки. 

Поверхнева модель визначає більше властивостей об'єкта в 

порівнянні з каркасною моделлю, але менше, ніж об'ємна. Вона 

використовується, коли немає необхідності визначати фізичні 

властивості об'єкта (маса, центр ваги і т.і.), а досить лише забезпечити 

можливість автоматизованого видалення невидимих ліній та інші 

ефекти візуалізації. 
Твердотільна модель дозволяє найбільш повно визначити 

геометричні характеристики об'єкта і дані для його візуалізації. При 
твердотільному моделюванні всі точки простору розмежовуються на 
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внутрішні і зовнішні стосовно об'єкта. Ця особливість дозволяє не 
тільки визначати фізичні властивості об'єкта, але й зручно утворювати 
складене тіло з простих. При цьому автоматично здійснюється 
побудова ліній перетинання. 

Процедура формування твердотільної моделі складається з  етапів: 
- створення простих геометричних тіл; 
- виконання над простими геометричними тілами  булевих 

операцій. 
Прості геометричні тіла визначаються за параметрами (куля, 

циліндр і т.і.) чи задаються кінематичним способом – обертанням 
контуру навколо заданої вісі або переміщенням контуру (утворюючої) 
за заданою траєкторією (направляючою). Для цього використовуються 
команди EXTRUDE (Витягування) та REVOLVE (Обертання). 

Для створення складніших просторових моделей 
використовуються команди редагування: UNION (Об’єднання), 
SUBTRACT (Віднімання), INTERSECT (Перетин). 

Якщо креслення повинне виконуватись у площині, паралельній 
заданій та розташованій від неї на деякій відстані, це можна задати за 
допомогою системної змінної ELEVATION (Підняття) яка  визначає 
відстань до паралельної площини (додатну або від’ємну). 

Перш, ніж починати креслення, слід визначити, який вид об'єкта 
буде головним. Головний вид повинен містити найбільшу кількість 
інформації про об'єкт і розташовуватися в лівому верхньому вікні. 

Об'єкт створюється за розмірами. Координати точок 
визначаються щодо поточної системи координат, встановленої в 
активному вікні. Початок і напрямок осей координат вказуються в 
кожному вікні. Напрямок осей координат можна змінювати за 
допомогою команди UCS. 

 

5.2 Порядок виконання роботи 

 
Перший етап роботи – створення креслення – прототипу 

(шаблону). 

5.2.1 Запустити AutoCAD 2016 та створити новий файл, система 

вимірювань – десяткова, границі креслення: 210х150, робочий 

простір Drafting & Annotation. 

5.2.2 Встановити крок сітки 5, крок переміщення курсору 5 і 

увімкнути візуалізацію сітки.  

5.2.3 Включити прив’язки: Endpoint, Center, Intersection, 

Nearest. 

5.2.4 Створіть новий шар ВІСІ та зробіть його поточним. 
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5.2.5 За допомогою команди LINE накреслити вісі координат 

товщиною 0.3 мм: 

- X, колір червоний, координати вершин 105,75 та 60,75; 

- Y колір зелений, координати вершин 105,75 та 105,30. 

Увага! У контекстному меню закладки встановіть панель View 

► Show panels ► Coordinates. 

5.2.6 Визначити нову систему координат: 

View ► Coordinates ►  3 Point 

вказати послідовно три точки так, як зазначено на рисунку 5.3 . Перша 

точка визначає початок системи координат, друга – позитивний 

напрямок осі Х, третя – позитивний напрямок осі Y. 

 

 

Рисунок 5.3 - Встановлення нової системи координат. 

 

5.2.7 Зберегти створену систему координат під будь-яким 

іменем: 

 UCS ► NAmed ► Save 
5.2.8 Накреслити вісь Z за допомогою команди LINE, колір 

синій за координатами 0,0,0 та 0,0,45 (вона спрямована 

перпендикулярно до площини екрана, тому невидима). 

5.2.9 Створити 4-х віконну конфігурацію екрана: 

View ►  Viewport Configuration ► Model Viewports 

► Four: Equal. 
5.2.10 Послідовно активізувати вікна мишею та установити для 

кожного з них відповідні настройки. 

Ліве верхнє вікно: 

- WORLDVIEW 1 (за замовчанням); 

- точка зору VPOINT 0,-1,0; 
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- положення вісей і масштаб зображення у вікні: 

View►Navigate2D►Zoom Center  0,0,0 200. 
Праве верхнє вікно: 

- WORLDVIEW 0; 

- точка зору VPOINT 1,0,0; 

- положення вісей і масштаб зображення у вікні: 

View►Navigate2D►Zoom Center  0,0,0 200. 

Ліве нижнє вікно: без змін. 

Праве нижнє вікно: 
Встановити режим ізометрії (згідно з рис. 5.4): 

View ► Views ► SW Isometric. 

 

 

Рисунок 5.4 - Встановлення ізометричної проекції. 

Отримаємо зображення як на рисунку 5.5 

 

 
Рисунок 5.5 - Встановлення ізометричної проекції. 
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Примітка. Елементи креслення можуть визначатися за 

допомогою курсору лише в площині XY поточної системи координат. 

У верхніх вікнах ця площина проєцюється у пряму лінію. Для того, 

щоб відновити можливість креслення у верхніх вікнах, необхідно 

ввести і зробити поточною в них систему координат, площина XY 

якої буде паралельна площині вікна. Для цього слід активізувати 

потрібне вікно та вирівняти площину XY: 

View ► Coordinates ►  View. 
5.3.9 Запам'ятати 4-х-віконну конфігурацію з установками 

атрибутів під будь-яким ім'ям: 

View ► Model Viewports ►  Named ► New 

Viewports. 
Приховайте шар ВІСІ. 

5.3.10 Перейти у простір листа, натиснувши у рядку під 

кресленням закладку Layout1. Якщо на полі креслення з'явилося 

зображення вікна, слід видалити його. 
5.3.11 Зберегти активне креслення як шаблон з іменем 3D.dwt, 

після чого закрити файл. 

 

Другий етап роботи – формування просторової моделі. 

 

У цій частині роботи слід виконати 3D-модель деталі, креслення 

якої наведене на рис. 5.6. 

 

Рисунок 5.6 – Завдання до роботи 
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5.3.12 Створити нове креслення AutoCAD за допомогою 

майстра на основі шаблона 3D.dwt: 

 Create New Drawing ►  Use A Template 
5.3.13 Змініть робочий простір на 3D Modeling. 

5.3.14 Активізувати ліве верхнє вікно. За замовчанням 

креслення відбуватиметься безпосередньо у площині XY. Щоб 

розташувати елементи у паралельній площині (вздовж вісі Z) слід 

змінювати значення системної змінної ELEVATION (додатні — зсув 

назовні екрану, від'ємні — всередину). Задати значення системної 

змінної ELEVATION -24. 

УВАГА! Для подальшого отримання твердотільних об'єктів 

необхідно виконувати цільні замкнені контури (якщо контур буде 

складатися з декількох окремих елементів — отримаємо відкриту 

поверхню). Цього можна досягти або за допомогою команди PLINE з 

ключами Arc, Line або звичайними командами LINE, CIRCLE та 

інші, та застосувати до накреслених примітивів команду JOIN 

(об'єднати). 

Home ► Modify ► Join 
Координати точок задавати відповідно до розмірів деталі. 

УВАГА! Також необхідно стежити за режимами прив'язок, тому 

що можна помилково прив'язатись до точки у паралельній площині. 

 

Рисунок 5.6 – Створення базового контура 
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5.3.15 На основі замкненого контура створити твердотільний 

об'єкт шляхом видавлювання на відстань 48 (рис. 5.8): 

Home ► Modeling ►  Extrude 
 

Примітка. Операція видавлювання виконується у напрямку 

перпендикулярно до площини примітива. 

 

Рисунок 5.8 – Створення базового тіла 

5.3.16 Активізувати праве верхнє вікно. Встановити значення 

змінної ELEVATION -32 та накреслити прямокутник 34х54:

RECTANG 7,-38 41,16.  
Створити твердотільний об'єкт видавлюванням прямокутника, 

висота видавлювання 64. 

5.3.17 Об'єднати створені об'єкти в один: 

Home ►Solid Editing ►  Union. 
Результат наведений на рис. 5.9. 

5.3.18 Активізувати ліве верхнє вікно. Встановити значення 

ELEVATION -25. Виконати креслення прямокутника 32х14 та 

окружності радіуса 13. 

УВАГА! Рекомендується вимкнути режим динамічних систем 

координат у інструментах креслення, тому що крок курсора може 

зсуватися в контексті елементів, що знаходяться під ним. 

Створити твердотільні об'єкти видавлюванням прямокутника та 

окружності на глибину видавлювання 50. Нові об'єкти повинні 
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виходити за межі раніше створеного об'єкта. 

 
Рисунок 5.9 - Результат об'єднання об'єктів 

 

5.3.19 Відняти два нові об'єкти від раніше створеного: 

Home  Edit  Subtract.  

На запит системи спочатку указати об’єкт, від якого слід 

відняти, а потім – об’єкти, що віднімаються. 

5.3.20 Активізувати праве верхнє вікно. Встановити значення 

ELEVATION -35. Виконати креслення прямокутника 20х6 та 

окружності радіуса 10. Створити твердотільні об'єкти видавлюванням 

прямокутника та окружності на глибину видавлювання 70. Відняти 

нові об'єкти з раніше створеного за допомогою команди Subtract.  

Результат наведений на рис. 5.10. 
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Рисунок 5.10 - Результат створення пазів та отворів 

5.3.21 Активізувати ліве нижнє вікно. Встановити значення 

ELEVATION -40. Виконати дві окружності радіусом 4. Створити 

твердотільні об'єкти видавлюванням на глибину видавлювання 60. 

Відняти нові об'єкти з раніше створеного за допомогою команди 

Subtract. 

Результат створення моделі наведений на рис. 5.11. 

 

Рисунок 5.11 - Результат створення моделі 

5.3.22 Для кращого сприйняття моделі слід у кожному вікні 

проекцій вимкнути сітку та прибрати невидимі лінії: 
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Home > Layers & View > Visual Styles > Hidden. 

Або зафарбувати модель. 

Home > Layers & View > Visual Styles > Realistic. 

Остаточний варіант наведений на рис. 5.12. 

 

 

Рисунок 5.12 - Просторова модель деталі 

5.3.23 Зберегти файл у власній папці з іменем 3Dmodel_N, де N- 

номер студента за списком. 

 

Третій етап роботи – створення креслення. 
 
5.3.2 Відкрити файл 3Dmodel_N і зберегти його під новим ім'ям 

3Dviz_N . 
Змініть робочий простір на 3D Modeling. 
Перейдіть до простору листа Layout1. 

Створіть три основні види деталі (спереду, зверху та збоку): 

Layout > Create View >Base >  From Model Space. 
З'явиться зафарбоване зображення виду спереду (головного). 

Клікніть мишею у верхній правій частині листа щоб розмістити вид. 

Натисніть Enter. 

Далі перемістіть курсор у нижню половину листа. Зверніть 

увагу, що зображення виду змінилося, а між видами підтримується 

проекційний зв'язок. Клікніть та створіть вид зверху. Аналогічно 

створіть вид збоку у правій верхній частині листа (рис). 

 



 12 

 

Рисунок 5.13 – Головні види деталі 

Коли буде створено три види, натисніть Enter. Стиль 

зображення видів зміниться на звичайний креслярський (контури та 

невидимі ребра). 

Так як видів на листі достатньо багато, відображення невидимих 

ліній треба вимкнути. Оберіть головний вид. Автоматично 

активізується вкладка Drawing View. Ввімкніть режим редагування: 

Drawing View >  Edit View 
Змініть стиль виду: 

Drawing View Editor > Appearance >  Visible Lines 
Зверніть увагу, що також змінилися стилі двох інших видів, 

тому що між ними підтримується однобічний зв'язок “parent-child” 

(успадкування атрибутів об'єкта-нащадка від батьківського об'єкта). 

Завершіть редагування виду: 

Drawing View Editor > Edit >  OK 
Накресліть вісі симетрії (LINE) та маркери центрів кіл на 

кожному виді. 

Annotate > Dimensions >  Center Mark 
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Рисунок 5.14 – Постановка вісей 

Виконайте виносний вид посередині листа. У якості 

батьківського виду оберіть вид зверху: 

Layout > Create View > Detail >  Circular 
За замовчанням масштаб виносного виду 2:1. Ввімкніть на 

ньому відображення невидимих ліній та пересуньте напис А(2:1) 

нижче (рис). 

 

 

Рисунок 5.15 – Виносний вид 
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Виконайте ізометричний кутовий переріз моделі. 

Налаштуйте стиль відображення лінії перерізу: 

Layout > Styles and Standards >  Section View Style 
Відкриється вікно Section View Style Manager. У ньому 

натисніть Modify та зробіть налаштування як на рис. 

 

Рисунок 5.16 – Налаштування лінії перерізу 

Використовуючи прив'язки та вирівнювання створіть лінію 

перерізу. У якості батьківського виду оберіть вид зверху. 

Layout > Create View > Section >  Full 
 

Розташуйте переріз вище головного виду за межами листа, тому 

що від відіграватиме проміжну роль у побудові. 
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Рисунок 5.17 – Допоміжний вид для побудови ізометричного розрізу 

 

Тепер створіть ізометричну проекцію з перерізу: 

Layout > Create View >  Projected 
У якості батьківського виду оберіть переріз. Розташуйте 

проекцію у правому нижньому куті на натисніть Enter. 
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Рисунок 5.18 – Розташування ізометричного розрізу 

 

Зменшіть тип та масштаб штрихування. Оберіть два об'єкти 

штриховки (рис 5.19). 

 
 

Рисунок 5.19 – Зони штриховки розрізу 

 

Зверніть увагу, що автоматично відкрилася закладка Drawing 

View Hatch Editor. У панелі Pattern оберіть ANSI31. У панелі 

Properties в поле Hatch Pattern Scale введіть 0.5 . 

Закрийте вкладку, натиснувши кнопку Close Hatch Editor 

праворуч. 

Проставте розміри згідно завдання. 
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5.2 Контрольні запитання 

5.2.1 Як створити шаблон? 
5.2.2 Які настройки необхідно виконати у шаблоні для 

двовимірних креслень? 
5.2.3 Які настройки необхідно виконати у шаблоні для креслень 

просторових моделей? 
5.2.4 Як визначити параметри системи координат? 
5.2.5 Як створити багатовіконну конфігурацію екрана? Як 

здійснюється перехід між вікнами? 
5.2.6 Які параметри додатково задаються для просторових 

моделей? Які команди для цього використовуються? 
5.2.7 Назвіть види просторових моделей. Для чого 

використовується кожен вид? 
5.2.8 Приведіть процедуру формування об’ємної моделі. 
5.2.9 Які основні команди використовуються для створення 

моделей? 
5.2.10 Які основні команди використовуються для редагування 

моделей? 
5.2.11 Як задаються параметри паралельної зсуненої площини? 

5.3 Зміст звіту 

5.3.1 Тема та мета роботи. 

5.3.2 Відповіді на контрольні запитання. 

5.3.3 Алгоритм етапів виконання 3D - моделі заданої деталі з 

описом команд. 

5.3.4 Алгоритм етапів виконання візуалізації 3D - моделі та 

отримування проекцій деталі з описом команд. 

5.3.5 Висновки з роботи. 
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